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IMAGENEX MODEL 882-GS  
GYRO STABILIZED 

MULTI-FREQUENCY IMAGING SONAR 
 

 
 
APPLICATIONS:    FEATURES: 
 

• ROV, AUV, & UUV         •   Ethernet (or Optional Serial) 
• Manned Submersibles         •   Programmable (format available) 
• Search & Recovery         •   Gyro stabilized transducer steering 
• Borehole/cave work         •   Simple set-up and installation 
• Drop sonar          •   Full scale range from 1 m to 100 m 
• Scientific Research         •   Orientation module 

        
 
 
 
 

 
Gyro-stabilization makes the high resolution 

882-GS sonar capable of crystal clear visualization 
of the ocean environment from moving platforms, no 
longer compromised by the blurring effects of host 
vehicle rotation. An advanced, low drift gyro is 
integrated directly into the sonar head, so the sonar 
can compensate for vehicle motion in real time with 
unprecedented accuracy, stability, and robustness. 

Using Ethernet communications, this all-in-
one, high performance digital imaging sonar 
exceeds 100 shots per second on short range at up 
to 2 mm range resolution, and can auto-adjust 
acoustic frequency and resolution to scan up to a 
100 m radius, 360° surrounding area. 

The Model 882-GS has low power, simple 
set-up, and small size that make it an ideal tool for 
large work ROV’s and small inspection vehicles. On 
it’s own it is an amazingly simple drop sonar and 
borehole inspection package: just add a laptop 
computer and power supply and run the included Imagenex software. 
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HARDWARE 
SPECIFICATIONS: 
FREQUENCY 675 kHz or 1 MHz (standard default settings) 

-Other frequencies can be selected through programmable 
software configurations  
(Tunable from 280 kHz to 1.1 MHz in 5 kHz steps) 

TRANSDUCER Imaging type, fluid compensated 
TRANSDUCER BEAM WIDTH 675 kHz:  1.8° x 20° 

   1 MHz:  0.9° x 10° 
RANGE RESOLUTION 1 m – 4 m:  2 mm (0.08”) 

5 m & up:   10 mm (0.4”) 
ORIENTATION MODULE (accuracies): 
     PITCH & ROLL ± 0.1° typical 
     HEADING (Magnetic) ± 1.0° typical 
MIN. DETECTABLE RANGE 150 mm (6”) 
MAX. OPERATING DEPTH 300 m and  

1000 m available 
Standard:  100 m on CAT5e (Ethernet) 
Cable length may be increased up to ~9000 m using an 
Ethernet extender.  Please enquire for more information. 

MAX. CABLE LENGTH 
 
 
         (Optional Serial Interface) 1000 m on typical twisted shielded pair (RS-485) 

Standard:  10 Mbps Ethernet (10 BASE-T) using TCP/IP 
Bit rate may vary if an Ethernet extender is in use. 

INTERFACE 
 
         (Optional Serial Interface) RS-485 serial interface @ 115.2 kbps (or optional RS-232) 
CONNECTOR               Ethernet 
 
                                      Serial 

IE55-1206-BCR 
 
IE55-1004-BCR 

POWER SUPPLY 20 – 32 VDC at less than 7 Watts 
DIMENSIONS  300 m unit: See drawing below  

1000 m unit: TBA 
WEIGHT:  In Air 
 
 
                  In Water 

300 m unit:  ~1.2 kg (~2.6 lbs) 
1000 m unit:  TBA 
 
300 m unit:  ~0.3 kg (~0.7 lbs) 
1000 m unit:  TBA 

MATERIALS  6061-T6 Aluminum & Polyurethane            
FINISH Hard Anodize 
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SOFTWARE 
SPECIFICATIONS: 

Win881AL.exe 
 

WINDOWS™ OPERATING SYSTEM Windows™ XP, Vista, 7, 8, 10 
MODES Sector, Polar and Side Scan  
GYRO MODES North Up, Heading Up, Target Steering 
RANGE SCALES 1 m, 2 m, 3 m, 4 m, 5 m, 10 m, 20 m, 30 m, 40 m,  

50 m, 60 m, 80 m, 100 m 
TRAIN ANGLES Continuous rotation, 3° increments 
SECTOR SIZE: 
    SECTOR MODE  
    POLAR MODE  

 
0° – 180°, 3° increments 
0° – 357°, 3° increments, or Continuous rotation 

STEP SIZES Slow (0.3°), Medium (0.6°), Fast (0.9°), Faster (1.2°), 
Fastest (2.4°) 

GRID TYPES Polar and rectangular 
FILE FORMAT (filename).81R 
RECOMMENDED 
MINIMUM COMPUTER 
REQUIREMENTS: 

2 GHz Pentium 4 
256 MB RAM 
20 GB Hard Disk 
1024 x 768 Screen Resolution 

 
 
 
 
 
 
 
ORDERING  
INFORMATION: 
300 m UNIT Standard 882-000-100 
1000 m UNIT Standard 882-000-101 
RS-232 Option                     -006 
RS-485 Option                     -007 
IP Address* (for Ethernet version only) Option                     -020 
 
*Note: Standard IP Address is 192.168.0.5   
 A different IP Address may be specified upon ordering. 
 
 

Product and company names listed are trademarks or trade names of their respective companies.
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IMAGENEX TECHNOLOGY CORP.

Model 882L 
Gyro Stabilized Scanning Sonar

(Ethernet Version)

Quick Start

Number 430 - 032

Revision Date Description
00 July 24, 2014 Release
01 September 24, 2014 Increase Minimum Power Supply to 2A
02 January 22, 2015 Added auto bias, and auto file size

Specifications subject to change without notice
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1.0 Introduction

The Model 882L is an advanced gyro-stabilized, high-resolution scanning sonar system that has been designed to provide simple, 
reliable, and accurate representation of underwater images. 

2.0 Getting Started:

The 882L was designed to be user friendly and simple to set up in the field. It is generally recommended however to perform a 
preliminary setup before heading out into the field. 

2.1 Step-By-Step Start Up Guide

1. Physically mount the sonar referring to Section 2.4 on page 5 for details.
2. Ensure 24VDC@ 2A minimum power supply is off
3. Referring to Appendix A – Ethernet Setup Guide, configure the network cards IP address.
4. Connect the RJ45 (looks like a large telephone connector) to the PC’s network card.
5. Plug the underwater connector to the sonar.
6. Deploy to stable, flat location
7. Power up the 882L.
8. Wait for gyro calibration to complete. The sonar, upon power up, will calibrate the motor, and automatically perform a gyro 

calibration. No communication to the gyro sub system is available at this time.
9. Verify the “Local Latitude” setting in the “.ini” file and adjust if necessary. Refer to Section 2.5.2 on page 11 for details
10. Launch the “Win881AL_GS.exe” program

 If file playback is desired, use the menu command “File->Open File to Playback”.
 If real-time operation is desired, use the menu command “File->Connect to Sonar Head”.

11. Proceed to Section 2.5 on page 6 for software instructions.
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2.2 Gyro Calibration
Imagenex Gyro enabled scanning sonars now incorporate an automatic gyro biasing feature which is selectable in the program. This 
mode continuously re-bias's the gyro in real time accommodating for temperature fluctuations. Refer to Table 2.1 on page 6 for details 
on enabling / disabling this mode. The information below describes the manual biasing mode which may be necessary in strong 
magnetic field environments. 

All gyros are sensitive to the environment (i.e. temperature, motion, Earth's rotation, etc.) and will naturally drift with time. Therefore,
from time to time, it is recommended to issue a gyro calibration to remove the accumulated drift.

It is ESSENTIAL that the sonar is completely stationary and at constant temperature during gyro calibration. ANY 
movement will cause undesirable drift in the gyro.

2.2.1 Manual Gyro Calibration procedure

Do not calibrate the gyro until the internal temperature of the sonar has stabilized, approximately 30-60minutes underwater.
1. Mount sonar on a level, stable surface, or settle the ROV on a flat bottom.
2. Under the “Options” Menu, select “Calibrate Gyro”.
3. Standard sonar operation is suspended during gyro calibration.
4. The message “Calibrating Gyro” will appear. Calibration takes approximately 30secs.
5. Once the message disappears, standard operation commences.
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2.3 Overview

While traditional scanning sonars provide excellent imagery, they have a significant short coming...they rely on the sonar being 
perfectly still during data acquisition. Imagenex has developed the ideal solution...the 882L. Figure 2.1, below, shows a non stabilized 
image taken while the sonar was spinning. Note the wavy lines in the lower 2 quadrants. Now refer to the same area scanned with 
Gyro stabilization enabled (Figure 2.2, below). Now the image is well defined and straight.
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Figure 2.1: Unstabilized Image
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Figure 2.2: Stabilized Image
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2.4 Hardware

 Figure 2.3: 882L

Figure 2.3, above, indicates the 882L in the “Transducer Up” orientation. 

 Transducer End. FRAGILE. This area MUST be exposed to the water with no obstruction. Do not mount sonar using this 
area. 

 Connect sonar cable. Ensure locking sleeve is used. Do not bend pins.

 Electronics Bottle. Use this area for mounting the sonar.
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2.5 Software 
After installing the “Win881AL_GS.exe” program (generally “C:\Program Files (x86)\Imagenex”), load the program by double-
clicking on its icon.

The program, which supports the 881A, 881L, 881A-GS, 881L-GS, 882L, and 882L will need to be told which sonar type is being 
connected. Choose 882L from: 

“System => Sonar Type => 882L”

This configures the program to operate in 882L mode.

 Figure 2.4: Options Menu

Ref Item Description

1 Enable Gyro Enables Gyro Stabilized Image. Deselect to operate as standard 882L.

2 Calibrate Gyro Calibrates gyro to compensate for drift.

3 Enable Gyro Auto Bias Enabling this puts the sonar into auto bias mode where the sonar will 
continuously re-bias the gyro in real time.  Disabling this mode requires
a manual bias as described in Section 2.2.1 on page 2.

4 Calibrate Compass Field Calibrates the internal Compass. To calibrate the compass, the 
sonar head MUST be rotated 360º (direction is irrelevant). Check 
“Calibrate Compass”, rotate 360º, then un-check “Calibrate Compass” 
to store the settings.

5 Calibrate Motor Calibrates Motor and realigns the sonar head position relative to the 
transducer position.

Table 2.1: Options Menu
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F

igure 2.5: Standard 882L Display
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Ref Item Description

1 Range / Frequency Display Display current acoustic range and frequency of sonar in yellow. 
Displays Grid scale and current gain in orange

2 Gyro stabilized operating mode Displays only when Gyro Stabilized Image is enabled. One of: North 
Up, Heading Up, or Target Steering.

3 File Recording information Displays “Not Recording” or “Recording...”

4 Communication Error Status Displays “No Connection” when communication to the sonar is 
interrupted.

5 Quick Setting Quick Setting for sonar range and gain

6 Wiper Current transducer position for the “ping”

7 Sonar Position Indicator The yellow circle indicates the current sonar position independent of the
transducer position. 

In North Up mode, the circle will transverse around the perimeter of the
sonar image which remains stationary in a North up orientation.

In Heading Up mode, the circle will remain stationary at the top of the 
screen, while the sonar image rotates.

In Target Steering mode, the circle will transverse around the perimeter 
of the sonar image which remains stationary

8 Gyro Stabilized Image mode selection Selects the various modes of display.

In North Up mode, the circle will transverse around the perimeter of the
sonar image which remains stationary in a North up orientation.

In Heading Up mode, the circle will remain stationary at the top of the 
screen, while the sonar image rotates according to the heading.

In Target Steering mode, the circle will transverse around the perimeter 
of the sonar image which remains stationary

9 Acquire Target Only active in “Target Steering mode, “Acquire Target” allow the user 
to select a target location. The sector will then be centred on the 
selected target and rotated to place the target at the top of the display. 
See Section 2.5.1, below for details.

Table 2.2: Main Display

2.5.1 Acquire Target

The 882L-GS has the ability to select a target of interest, and automatically centre and scan that target on screen. The procedure is as 
follows.

1. Ensure the gyro is enabled and in “Target Steering” mode. The image will perform a full polar scan.

2. Select the button “Acquire Target”. The mouse cursor will change to   

3. Select desired target on screen The screen will automatically change to a top sector view with
the target centred within the sector

This is described further below.
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In Figure 2.6, above, the “Acquire Target” was selected and the mouse cursor changed to   . In this example, the target of 

interest is positioned under the target cursor.
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Figure 2.6: Acquire Target button has been selected
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In Figure 2.7, above, the desired target from Figure 2.6 was selected. The screen automatically centred the target within a sector and 
rotated the sector to the top of the screen. The sonar will now scan the sector with the centred target.

To return, select “Release Target” to remove the sector restrictions and train angle.
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2.5.2 Latitude Adjustment and Compass Declination

The geographical local latitude compensates for drift caused by the Earth's rotation. To set the latitude of the current location, open the
file “Win881AL.ini” in a text editor and edit the lines:

• Local Latitude=49.250000 → (0 to 90 for northern latitudes, 0 to -90 for southern latitudes)
• CompassDeclination=16.5 → (±180º, offset to Magnetic North. West is negative, East is positive).

To match the approximate location of the sonar.
Once these are set, run the “Win881AL_GS.exe” program as per usual.

Initiate a Gyro Calibration once the sonar is operating. 

The “Local Latitude” will not take effect until a “CALIBRATE GYRO” command is initiated
manually under the “Options” menu.

The compass declination angle is used for displaying the sonar image referenced to True North rather than Magnetic North.
The default values are for Vancouver, BC, Canada which has a latitude of 49.25º North and a magnetic compass declination of 16.5º 
(as of 2014).

2.5.3 File Size Limits

Storing video can generate very large files, The software is able to automatically split the recorded file in predefined file sizes as 
shown below in Figure 2.8

Figure 2.8: Auto File Sizes

In order to re-join two split files, from the command prompt type:

copy /b “Source1.81R”+”Source2.81R” “dest.81R”

without the quotes.
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Appendix A – Ethernet Setup Guide

The Imagenex Model 882L sonar system consists of an underwater sonar head connected via Ethernet directly (or indirectly) to a 
Windows © based computer.

This document covers the necessary setup procedures to enable your Windows© XP© based PC to communicate with the sonar.

Ethernet Cable
The included Ethernet cable specifications are:

 Cat 5e 
 RJ-45
 568B wiring scheme

If this cable needs to be replaced, ensure that the above specifications are met. 

A1. Configuration of Windows XP Ethernet Communications 

For the 882L system, the following Address’s are used

PC 
IP Address 192.168.0.X
Subnet Mask 255.255.255.0

Where ‘X’ is a decimal number between 3 and 224. The number ‘1’ is reserved for a network server ‘5’ is reserved for the 
882L sonar head, and 255 is reserved for broadcasting. 

The 882L sonar head has a statically assigned IP Address of 192.168.0.5. This is the number to enter for “IP Address” in
the “System” menu of the 882L program.

The Recommended PC’s IP address and Subnet Mask on the PC are:

IP Address 192.168.0.3
Subnet Mask 255.255.255.0

On a Windows© XP© based machine, this is done as follows:

1. Navigate to the Control Panel and double click “Network Connections”
2. Right click on the Ethernet interface you wish to connect with and select “Properties”
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Figure A.1: Local Area Connection Properties Dialogue Box

3. Select Internet Protocol (TCP/IP) and select “Properties”

Figure A.2: TCP/IP Priorities Dialogue Box

4. Enter the information shown above in Figure A.2 and click “OK” to accept the changes. 
5. Click “OK” again to accept the changes. 
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Now your computer is on the same “Network” as the sonar head. When starting the “Win881AL_GS.exe” program, the IP address 
stored in the “882L.INI” file is read and a connection will be established.

The sonar head has a statically assigned IP Address of 192.168.0.2. Enter this number in the menu item 
“Setup -> IP Address”. 

The sonar head will run fine. However, if communication to the head does not function properly, try the suggestions located on 
page 16.

A2. Configuration of Windows 7 Ethernet Communications
Windows 7 requires a few more steps than XP for network configuration, but is generally the same.

On a Windows© 7 based machine, this is done as follows:

1. Go to the Start Menu and select “Control Panel”.
2. Select “Network and Sharing Center”.

Figure A.3: Windows 7 - Network and Sharing Center

3. Select “Change adaptor settings”.
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Figure A.4: Windows 7 - Network Connections

4. Right-click on “Local Area Connection” and select “Properties”.

Figure A.5: Windows 7 - Local Area Connection
Properties

5. Select “Internet Protocol Version 4 (TCP/IPv4)” and select “Properties”.
6. Continuing from item 4 and Figure A.2, on page 13, enter the required information. 
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Appendix B – Troubleshooting Communications 

Disable any network bridges that are present
 A network bridge allows a separate port, such as “USB”, or “Firewire” to piggyback the Ethernet connection.
 Under “Network Connections”, if there is a network bridge icon, disable it.

Disable any other network devices that are present on the computer
 Often, if there are multiple network cards present, Windows may get confused on which one to communicate through. 

This is more of an issue on laptops with wireless connections.
 Right-click on each connection and select “Disable”.

Under “Network Connections”, right-click on the Ethernet card and select properties  .

Clear unnecessary network protocols
 De-select all services except for “Internet Protocol (TCP/IP)”

Remove any firewalls present (Note that Windows© has a rudimentary firewall built into it. Disable this one first).
 Select the “Advanced” Tab. De-select the Firewall option (if present).

Click on “Configure” (in the “General” tab) and a new dialogue box will appear.

Set Link speed to “Auto” or “10Mbps”
 In the “Advanced” tab, select  “Link Speed / Duplex Mode” and set to either “Auto Mode” or “10 Full Mode”.

Disable any power saving that shuts down the Ethernet card.
 In the “Advanced” tab, select “Link Down Power Saving” and set to “Disable”. 
 In the “Power Management” tab, de-select any power saving option.

Repair the Ethernet connection.
Windows remembers the hardware address for each socket. To clear the Windows settings:

 Right click on the Local Area Connection. 
 Select “Repair”.
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IMAGENEX  .81R  RAW DATA FILE FORMAT 

 
Version: 1.00 

 

The .81R file format is used for the following gyro stabilized sonar heads: 

 

Model 881A-GS 

Model 881L-GS 

Model 882A 

Model 882L 
 

 

For each sonar ping, the following sections are written to the .81R file. 

 

1. Ping Header - 1024 bytes 

2. Device List - 1024 bytes 

3. Raw Sonar Data - variable length 

4. Internal Sensor Data 

5. External Sensor Data 

6. Future Expansion 

7. Video Frame (if available) 

 

 

1. Ping Header 
- contains overhead information such as total number of bytes this ping, byte offsets and lengths 

of each section, ping timestamp, frequency, range, gain, etc. 

 

2. Device List 
- contains information on all connected devices (i.e. sonar head, GPS, MRU, Gyro/Heading, 

Sound Velocity sensor, etc.). Includes the device name, transfer speed, rep-rate, mounting offsets, 

mounting angles and data latency. Information in this section is not required and may be zero 

filled. 

 

3. Raw Sonar Data 
- contains Switch Data Command, Sonar Return Header and Raw Sonar Data 

 

4. Internal Sensor Data 
- contains values from optional sensors installed inside the sonar head (i.e. MRU) 

 

5. External Sensor Data 
- contains values from external sensors 

 

6. Future Expansion 
 

7. Video Frame 
- if video is available from a connected USB frame grabber, the video frame is written to the file 

after the current ping data 
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Storage Format 

 

All data is stored LSB first (least significant byte first or "Little-Endian" mode). The following 

conventions are used: 

 

char  1-byte signed value 

BYTE  1-byte unsigned value 

ASCII  1-byte unsigned value 

short  2-byte signed value    (LSB,MSB) 

WORD  2-byte unsigned value    (LSB,MSB) 

int  4-byte signed value    (LSB,MDL,MDH,MSB) 

DWORD 4-byte unsigned value    (LSB,MDL,MDH,MSB) 

float  4-byte single precision floating point value (LSB,MDL,MDH,MSB) 
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Section 1:   Ping Header   (length = 1024 bytes) 

 

Byte Description Format 

0 '8' - Ping Header byte 0 ASCII 

1 '1' - Ping Header byte 1 ASCII 

2 'R' - Ping Header byte 2 ASCII 

3 Sonar Type 

0 = Model 881L-GS 

1 = Model 881A-GS 

2 = Model 882L 

3 = Model 882A 

BYTE 

4-7 Total Bytes This Ping (including Ping Header) DWORD 

8 - 9 .81R File Version 

0 = 1.00 - initial release 

WORD 

10 - 27 Ping Timestamp - (18 bytes) 

DDMMYYYYHHMMSSmmmh 

10-11:  DD - day, 01-31 

12-13:  MM - month, 01-12 

14-17:  YYYY - year 

18-19:  HH - hours, 00-23 

20-21:  MM - minutes, 00-59 

22-23:  SS - seconds, 00-59 

24-26:  mmm - milliseconds, 000-999 

27:        NULL 

 

ASCII 

28 Reserved - always 0          (1 byte) BYTE 

29 - 58 Sonar Control Program Version Number (30 bytes) 

i.e. "Version 1.0.1.5 (19Sept14)" plus zero fill 

ASCII 

59 - 62 Byte offset to previous 81R Ping Header 

 

Note: all byte offsets are referenced to the beginning of the 

current Ping Header 

DWORD 

63 Status Byte 1 

Bit 0:  1 = internal sensors available 

Bit 1:  1 = external sensors available 

Bit 2-7:  Reserved 

BYTE 

64 Status Byte 2 - Reserved - always 0 BYTE 

65 Status Byte 3 - Reserved - always 0 BYTE 

66 Status Byte 4 - Reserved - always 0 BYTE 

67 Status Byte 5 - Reserved - always 0 BYTE 

68 Status Byte 6 - Reserved - always 0 BYTE 

69 Status Byte 7 - Reserved - always 0 BYTE 

70 Status Byte 8 - Reserved - always 0 BYTE 

71 - 74 Reserved - always 0          (4 bytes) BYTE 

75 - 78 Ping Header length - 1024 DWORD 

79 - 82 Byte offset to Device List - 1024 DWORD 

83 - 86 Device List length - 1024 DWORD 

87 - 90 Byte offset to Raw Sonar Data - 2048 DWORD 

91 - 94 Raw Sonar Data length - variable DWORD 
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95 - 98 Byte offset to Internal Sensors (0 if not available) DWORD 

99 - 102 Internal Sensor length (0 if not available) DWORD 

103 - 106 Byte offset to External Sensors (0 if not available) DWORD 

107 - 110 External Sensor length (0 if not available) DWORD 

111 - 318 Reserved - always 0          (208 bytes) BYTE 

319 Transducer Up/Down, Display Mode 

Bits 0-2: 000 = North Up 

               001 = Heading Up 

               010 = Target Steering 

Bits 3-6: Reserved 

Bit 7:      Transducer Up/Down 

                0 = Down, 1 = Up 

BYTE 

320 Start Gain (dB) BYTE 

321 Sector Width Command 

0 to 120 = 0 to 360 Degrees in 3 degree increments 

BYTE 

322 Train Angle Command 

0 to 119 = 0 to 357 Degrees in 3 degree increments 

BYTE 

323 Step Size Command 

0 = No Step 

1 = 0.3 Degrees (Slow) 

2 = 0.6 Degrees (Medium) 

3 = 0.9 Degrees (Fast) 

4 = 1.2 Degrees (Faster) 

8 = 2.4 Degrees (Fastest) 

BYTE 

324 Mode 

0 = Sector 

1 = Polar 

2 = Sidescan 

BYTE 

325 - 328 Range Offset (meters) float 

329 - 332 Absorption (dB/meter) float 

333 Reserved - always 0 BYTE 

334 - 337 Pulse Length (microseconds) DWORD 

338 - 341 Sound Velocity (meters/second) float 

342 - 345 Acoustic Transmit Frequency (Hz) float 

346 - 349 Sonar Ping Repetition Rate (seconds) float 

350 - 352 Reserved - always 0 BYTE 

353 - 356 Samples per ping DWORD 

357 - 360 Sector Size (degrees) float 

361 - 364 Train Angle (degrees) float 

365 - 368 Step Size - Angle Increment (degrees) float 

369 - 372 Acoustic Range Setting (meters) float 

373 - 376 Range Resolution (meters) float 

377 - 380 Ping Number DWORD 

381 System Information Flag BYTE 

382 Gyro Status (0=Disabled, 1=Enabled) BYTE 

383 - 386 Mounting Angle Offset (-180 to +180 in decimal degrees) float 

387 - 390 Local Latitude (-90 South to +90 North in decimal degrees) float 

391 - 394 Compass Declination (-180 to +180 in decimal degrees) float 

395 - 1023 Reserved - always 0        (629 bytes) BYTE 
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Section 2:  Device List    (length = 1024 bytes) 

 

Note: information in this section is not required and may be zero filled. 

 

Each connected device contains the following 64-byte structure: 

 

Byte Description Format 

0 - 15 Device Name (16 bytes)  i.e. "881L-GS Sonar" plus zero fill ASCII 

16 - 19 Transfer Speed (bits per second) DWORD 

20 - 23 Repetition Rate (seconds) float 

24 - 27 Starboard mounting offset (meters, portside is negative) float 

28 - 31 Forward mounting offset (meters, aft is negative) float 

32 - 35 Vertical mounting offset (meters, up is negative) float 

36 - 39 Yaw - mounting offset (degrees, counter-clockwise is negative) float 

40 - 43 Pitch - mounting offset (degrees, nose down is negative) float 

44 - 47 Roll - mounting offset (degrees, portside roll is negative) float 

48 - 51 Latency (seconds) float 

52 - 63 Reserved - always 0          (12 bytes) BYTE 

 

 

Device 1 (Sonar Head): 

- Byte 0 = Byte offset to Device List (from Ping Header, Bytes 79-82) 

- note: sonar head transfer speed is 10 for 10Mbps or 100 for 100Mbps 

 

Device 2 (GPS Antenna): 

- Byte 0 = Byte offset to Device List + 64 

 

Device 3 (MRU): 

- Byte 0 = Byte offset to Device List + 128 

 

Device 4 (Gyro/Heading): 

- Byte 0 = Byte offset to Device List + 192 
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Section 3:  Raw Sonar Data   (length = Variable) 

 

The Raw Sonar Data section contains the communications transfers to and from the sonar head 

for the current ping. The transfers consist of the Switch Data Command to the sonar head as well 

as the Sonar Return Header and Sonar Echo Data from the sonar head. The length of this section 

varies depending on the type of sonar head. 

 

 

 

The following tables describe the total number of bytes stored for each sonar head type: 

 

 

 

--------------------------------------------------------------------------------------------------------------------- 

 

Sonar Type = Model 881L-GS 

Ping Header Byte 3 = 0 

 

1. Switch Data Command - 128 bytes 

2. Sonar Return Header - 256 bytes 

3. Sonar Echo Data - 500 bytes (IBX mode) 

Total = 884 bytes 

 

Byte Offset  Description   Length 

0000 - 1023  Ping Header   1024 

1023 - 2047  Device List   1024 

2048 - 2175  Switch Data Command  128 

2176 - 2431  Sonar Return Header  256 

2432 - 2931  Sonar Echo Data  500 

 

For IBX mode, the Sonar Echo Data starts at byte offset 2432 and consists of 500 range bins of 8-

Bit (0-255) echo intensity values. Each range bin is (Range/500) in length. Range (in meters) is 

located in "Range" (Bytes 20-21) of the Sonar Return Header. Range bins assume a sound 

velocity of 1500m/s. The angular position of the ping echo is encoded in "Transducer Head 

Position" (Bytes 35-36) of the Sonar Return Header. 

 

Please refer to document "425-050-01 - 881L - GS Ethernet Specifcation.pdf" for detailed 

information about the Sonar Return Data format for the Model 881L-GS sonar head. 

 

--------------------------------------------------------------------------------------------------------------------- 
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--------------------------------------------------------------------------------------------------------------------- 

 

Sonar Type = Model 881A-GS 

Ping Header Byte 3 = 1 

 

1. Switch Data Command - 40 bytes 

2. Sonar Return Header - 32 bytes 

3. Sonar Echo Data - 500 bytes (INB mode) 

Total  = 572 bytes 

 

Byte Offset  Description   Length 

0000 - 1023  Ping Header   1024 

1023 - 2047  Device List   1024 

2048 - 2087  Switch Data Command  40 

2088 - 2119  Sonar Return Header  32 

2120 - 2619  Sonar Echo Data  500 

 

For INB mode, the Sonar Echo Data starts at byte offset 2120 and consists of 500 range bins of 7-

Bit (0-127) echo intensity values. Each range bin is (Range/500) in length. Range (in meters) is 

located in "Range" (Byte 7) of the Sonar Return Header. Range bins assume a sound velocity of 

1500m/s. The angular position of the ping echo is encoded in "Transducer Head Position" (Bytes 

5-6) of the Sonar Return Header. 

 

Please refer to document "425-051-03 - 881A - gyro Serial Specifcation.pdf" for detailed 

information about the Sonar Return Data format for the Model 881A-GS sonar head. 

 

--------------------------------------------------------------------------------------------------------------------- 
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--------------------------------------------------------------------------------------------------------------------- 

 

Sonar Type = Model 882L 

Ping Header Byte 3 = 2 

 

1. Switch Data Command - 128 bytes 

2. Sonar Return Header - 256 bytes 

3. Sonar Echo Data - 500 bytes (IBX mode) 

Total = 884  bytes 

 

Byte Offset  Description   Length 

0000 - 1023  Ping Header   1024 

1023 - 2047  Device List   1024 

2048 - 2175  Switch Data Command  128 

2176 - 2431  Sonar Return Header  256 

2432 - 2931  Sonar Echo Data  500 

 

For IBX mode, the Sonar Echo Data starts at byte offset 2432 and consists of 500 range bins of 8-

Bit (0-255) echo intensity values. Each range bin is (Range/500) in length. Range (in meters) is 

located in "Range" (Bytes 20-21) of the Sonar Return Header. Range bins assume a sound 

velocity of 1500m/s. The angular position of the ping echo is encoded in "Transducer Head 

Position" (Bytes 35-36) of the Sonar Return Header. 

 

Please refer to document "425-xxx-xx - 882L - GS Ethernet Specifcation.pdf" for detailed 

information about the Sonar Return Data format for the Model 882L sonar head. 

 

--------------------------------------------------------------------------------------------------------------------- 
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--------------------------------------------------------------------------------------------------------------------- 

 

Sonar Type = Model 882A 

Ping Header Byte 3 = 3 

 

1. Switch Data Command - 40 bytes 

2. Sonar Return Header - 32 bytes 

3. Sonar Echo Data - 500 bytes (INB mode) 

Total = 572 bytes 

 

Byte Offset  Description   Length 

0000 - 1023  Ping Header   1024 

1023 - 2047  Device List   1024 

2048 - 2087  Switch Data Command  40 

2088 - 2119  Sonar Return Header  32 

2120 - 2619  Sonar Echo Data  500 

 

For INB mode, the Sonar Echo Data starts at byte offset 2120 and consists of 500 range bins of 7-

Bit (0-127) echo intensity values. Each range bin is (Range/500) in length. Range (in meters) is 

located in "Range" (Byte 7) of the Sonar Return Header. Range bins assume a sound velocity of 

1500m/s. The angular position of the ping echo is encoded in "Transducer Head Position" (Bytes 

5-6) of the Sonar Return Header. 

 

Please refer to document "425-054-0C - 882A - Serial Specifcation.pdf" for detailed 

information about the Sonar Return Data format for the 882A sonar head. 

 

--------------------------------------------------------------------------------------------------------------------- 
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Section 4:  Internal Sensor Data 
 

This section is reserved for future use. 

 

Byte offset to Internal Sensors, (Ping Header, Bytes 95-98)  =  0 

Internal Sensor length, (Ping Header, Bytes 99-102)  =  0 

 

 

 

 

 

Section 5:  External Sensor Data 
 

This section is reserved for future use. 

 

Byte offset to External Sensors, (Ping Header, Bytes 103-106)  =  0 

External Sensor length, (Ping Header, Bytes 107-110)  =  0 

 

 

 

 

 

Section 6:  Future Expansion 
 

This section is reserved for future use. 
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Section 7:  Video Frame   (length is variable) 
 

Byte Description Format 

 Bitmap Header  

0 'B' - Video Frame Header byte 0 ASCII 

1 'M' - Video Frame Header byte 1 ASCII 

2 - 5 Video Frame Filesize 

14 + 40 + (ImageWidth x ImageHeight x 3) bytes 

DWORD 

6 - 7 Reserved1 - always 0 WORD 

8 - 9 Reserved2 - always 0 WORD 

10 - 13 Image Data Offset = 54 DWORD 

   

 Bitmap Information Header  

14 - 17 HeaderSize = 40 DWORD 

18 - 21 ImageWidth (in pixels) DWORD 

22 - 25 ImageHeight (in pixels) DWORD 

26 - 27 NumberOfImagePlanes = 1 WORD 

28 - 29 BitsPerPixel = 24 WORD 

30 - 33 CompressionMethod = 0 DWORD 

34 - 37 SizeOfBitmap = (ImageWidth x ImageHeight x 3) DWORD 

38 - 41 HorzResolution = 0 DWORD 

42 - 45 VertResolution = 0 DWORD 

46 - 49 NumColorsUsed = 0 DWORD 

50 - 53 NumSignificantColors = 0 DWORD 

   

 24 Bit ImageData (stored as 3 bytes per pixel)  

54 - 57 Pixel 0 - Blue, Green, Red (lower-left corner of image) BYTE 

58 - 60 Pixel 1 - Blue, Green, Red BYTE 

. . . 

. . . 
Video Frame 

Filesize-3 
Pixel N (ImageWidth x ImageHeight - 1) - Blue, Green, Red 

(upper-right corner of image) 

BYTE 
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